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INSTRUCTION MANUAL

Megapixel Camera
THIS INSTALLATION SHOULD BE MADE BY A QUALIFIED 
SERVICE PERSON AND SHOULD CONFORM TO ALL LOCAL 
CODES.
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Please read this instruction manual carefully in order to ensure correct installation. In addition, 
be sure to read carefully the electronic manual contained in the supplied CD-ROM to ensure 
correct operation of the camera.
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Recording times and target sizes (Insert at the end 
of this manual)

MEMO: This manual covers three models. Any difference among the three models is indicated when 
necessary.
中
文

1Transportation screw and treaded holes 
for mounting (Top and Bottom)

When using a camera mount base (sold 
separately) etc., use an attachment screw 
shorter than 10 mm / 0.4 in.

Install the camera in a correct location so 
that the intended object can be monitored 
properly.
You should also adjust on the monitor 
side.

• If you want to use a commercially available 
platform for the camera, select an 
appropriate type, taking into consideration 
the gross weight of the camera and 
platform, and secure it on a firm place.

• Images may blur under extremely bright 
lighting; adjust the lighting angle to get 
clear images.

1

Lens cap

1/4”-20 UNC

Installing CameraInstalling Camera
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Information To User

This equipment has been tested and found to 
For US and Canadaian Users
Safety Guard

CAUTION: Changes or modifications not 
expressly approved by the manufacturer may 
void the user’s authority to operate this 
equipment.

comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable 
protection against harmful interference in a 
residential installation. This equipment 
generates, uses and can radiate radio frequency 
energy and, if not installed and used in 
accordance with the instructions, may cause 
harmful interference to radio communications. 
However, there is no guarantee that interference 
will not occur in a particular installation.
If this equipment does cause harmful 
interference to radio or television reception, 
which can be determined by turning the 
equipment off and on, the user is encouraged to 
try to correct the interference by one or more of 
the following measures.
• Reorient or relocate the receiving antenna.
• Increase the separation between the 

equipment and receiver.
• Connect the equipment into an outlet on a 

circuit different from that to which the receiver 
is connected.

• Consult the dealer or an experienced radio/
TV technician for help.

For the customers in Canada

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF 
ELECTRIC SHOCK, DO NOT REMOVE 
COVER (OR BACK).

NO USER-SERVICEABLE PARTS INSIDE.

REFER SERVICING TO QUALIFIED 
SERVICE PERSONNEL.

The lightning flash with arrowhead 
symbol, within an equilateral triangle, is 
intended to alert the user to the presence 
of uninsulated “dangerous voltage” 
within the product’s enclosure that may 
be of sufficient magnitude to constitute a 
risk of electric shock to persons.
The exclamation point within an 
equilateral triangle is intended to alert the 
user to the presence of important 
operating and maintenance (servicing) 
instructions in the literature 
accompanying the product.

WARNING: To reduce a risk of fire or electric 
shock, do not expose this appliance to rain or 
moisture. This class B digital apparatus complies with 

Canadian ICES/NMB-003.

Precautions
■ In case of a problem
Do not use the unit if smoke or a strange odor 
comes from the unit, or if it seems not to function 
correctly. Turn off the power immediately and 
disconnect the power cord, and then consult your 
dealer or an Authorized Sanyo Service Center.

■ Do not open or modify
Do not open the cabinet, as it may be dangerous 
and cause damage to the unit. For repairs, 
consult your dealer or an Authorized Sanyo 
Service Center.

■ Be careful when handling the unit
To prevent damage, do not drop the unit or 
subject it to strong shock or vibration. 

■ Do not put objects inside the unit
Make sure that no metal objects or flammable 
substance get inside the unit. If used with a 
foreign object inside, it could cause a fire, a 
short-circuit or damage. Be careful to protect the 
unit from rain, sea water, etc. If water or liquid 
gets inside the unit, turn off the power 
immediately and disconnect the power cord, and 
then consult your dealer or an Authorized Sanyo 
Service Center.

■ Do not install this unit close to magnetic 
fields

The magnetic fields may result in unstable 
operation.
1
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For EU Users For Russian Users
This product certified by official 
certification company which is 
authorized by Russian Federation.

ДЛЯ ПОЛЬЗОВАТЕЛЕЙ 
РОССИЯ
Данная продукция 
сертифицирована официальным 
органом по сертификации 
Российской Федерации.

Please note:
Your SANYO product is designed and 
manufactured with high quality 
materials and components which can 
be recycled and reused.
This symbol means that electrical and 
electronic equipment, at their 
end-of-life, should be disposed of 
separately from your household waste.
Please dispose of this equipment at 
your local community waste collection/
recycling centre.
In the European Union there are 
separate collection systems for used 
electrical and electronic products.
Please help us to conserve the 
environment we live in!

This symbol mark and recycle 
system are applied only to EU 
countries and not applied to the 
countries in the other area of the 
world.

SANYO FISHER Sales (Europe) GmbH
Stahlgruberring 4, D-81829 München, 
Germany

SANYO Electric Co., Ltd.
1-1, Sanyo-cho, Daito City, Osaka 574-8534, 
Japan

■ Protect from humidity and dust
To prevent damage, do not install the unit where 
there is greasy smoke or steam, where the 
humidity may get too high, or where there is a lot 
of dust.

■ Protect from high temperatures
Do not install close to stoves, or other heat 
sources, such as spotlights, etc., or where it could 
be subject to direct sunlight, as this could cause 
deformation, discoloration or other damage.
Be careful when installing close to the ceiling, in 
a kitchen or boiler room, as the temperature may 
rise to high levels.

■ Cleaning
• Dirt can be removed from the cabinet by wiping 

it with a soft cloth. To remove stains, wipe with 
a soft cloth moistened with a soft detergent 
solution and wrung dry, then dry by wiping with 
a soft cloth.

• Do not use benzine, thinner or other chemical 
products on the cabinet, as this may cause 
deformation and paint peeling. Before using a 
chemical cloth, make sure to read all 
accompanying instructions. Make sure that no 
plastic or rubber material comes into contact 
with the cabinet for a long period of time, as 
this may cause damage or paint peeling.
2
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Parts Names and Functions
MENU SET

RESET

A CB D E

Side cover
After configuring settings, close the cover. 
Be sure to secure the cover with the 
supplied screw.

SD card

SD card slot

Operation Buttons

MENU button
Displays the main menu.

jl button
Moves the cursor upward/downward.

dc button
Changes the setting value or moves the 
cursor to the right/left. 

RESET button
Press with a pen or other pointed object.
• Restarts the camera.
• Resets the settings.

To return all settings to defaults (factory 
settings), press the RESET button while 
holding down the MENU button.

SET button
Selects the menu and confirms settings.

A

B

C

D

E

MEMO:The focus and zoom of live video can be adjusted. &P13

■Power/Error indicator

■Side Face

• Power ON : Lit (Startup time: 30 sec)
• Power OFF : Off
• Error (failure) : Blinks

MEMO:
To enable the power indicator, via the network, set [POWER LED 
(FRONT)] to "ON" on the OPTION SETTINGS screen.
3
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■Rear Face
& For connections, see pages 11 and 12.

1Control terminals
When connecting the cable, press and hold 
down the protrusion of the terminal, insert the 
cable into the terminal, and then release the 
protrusion. 

ZOOM terminal
Used to zoom in/out by connecting an 
external switch. 
• DC ±(6-12V), +: WIDE, –: TELE

FOCUS terminal
Used to perform the focus adjustment 
remotely by connecting an external switch.
• DC ±(6-12V), +: FAR, –: NEAR

COM terminal (Earth terminal)

ALARM OUT terminal
Used to connect to an external buzzer or 
lamp. 
When an alarm is detected, the device 
connected to the terminal notifies that an 
alarm is detected. 

ALARM IN 1/2 terminal
Used to connect an external alarm switch, 
infrared sensor, or other device.
It can also be used as a switching terminal 
for color and black/white video modes.

2SD OUT connector (BNC type)
Outputs SD (Standard Definition) video.

3AC24V / DC12V terminals
Connect this terminal to the power supply.
• When the camera is turned on, the 

POWER lamp lights.

4LAN connector (RJ-45)
Used to connect the camera to your network. 

5EX-HDD connector
Connects this connector to the external hard 
disk case (VA-HDC4000) dedicated to use 
with this camera.
For details, see the manual for the hard disk 
case.

6HDMI connector
Outputs HD (High Definition) video. Connect 
this connector to an HD video device.

MEMO:
Select the SD OUT or HDMI terminal in on the 
TV OUT SETTING screen via the network.

ALARM IN 1 ALARM
IN 2ALARM OUT

ZOOM
FOCUS

POWER

AC24V

GND DC
12VCOM

SD
OUT

EX-HDD
LAN

456

3

ALARM IN 1 ALARM
IN 2ALARM OUT

ZOOM
FOCUS

COM

1

A B C D E

2 POWER 
lamp

A

B

C

D

E

4



L5CL2_XE_US(INSTRUCTION).book  5 ページ  ２００８年８月２５日　月曜日　午後３時４３分
What You Can Do
You can display the menu screen on your PC and 
configure settings.
Network Monitoring System

By connecting the camera to your PC via 
LAN cable, you can operate various 
functions required for monitoring from 
your PC’s Web browser (Internet 
Explorer) via the network.

Security Measures

b Authentication by user ID and 
password is required when an access 
is attempted.

b Number of PC’s that can access the 
camera can be restricted.

b SSL can be used to encrypt the 
content of communication.

Full High Definition

A high definition monitor can be 
connected to enable monitoring with HD 
video device.

Recording and Playing back 
Live Video

bRecording
• Media (an SD card or external hard disk) 

can be installed on the camera to enable 
recording of live video when an alarm is 
detected.
Still image and video are recorded.

• Recording can be programmed using 
timer and/or schedule functions.

• Optional software can be used to record 
(JPEG) live video on a PC.

bDownloading and Playing 
back

• The supplied software 
"DLViewer_HDCDownloader" can be 
used to download live video recorded 
through the camera to your PC for 
playback.

• Immediate playback is possible by 
installing the SD card or external hard 
disk directly to a PC.
5
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Alarm Functions

bDetection
• The camera has a built-in motion sensor.

The face detection function works in 
conjunction with the motion sensor to 
detect presence of human.

• Two types of alarm input, such as door 
open and close, can be set.

bNotification
• When an alarm is detected, you can 

receive the image data as e-mail 
attachment.

• A buzzer or lamp can be used to notify you 
of detection of alarm when you are in a 
distant place from the monitor.

• When the alarm condition is detected, the 
object on the screen is zoomed in.

Not detected Detected

Clipping Function

You can clip a part of the live video for 
intensive monitoring and display it on 
the monitor.

Privacy Masks

The privacy masks can be used to 
protect privacy by hiding certain part of 
the monitored image. 
(Maximum 5 masks)
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Network Settings Procedure
■Checking the Operating Environment
• PC : IBM PC/AT and compatibles
• OS : Windows XP Professional/Windows Vista
• CPU : Core2Duo E6700 2.66 GHz or higher
• Memory : Windows XP : 1GB or more

Windows Vista : 2GB or more
• Network interface : 100Base-TX /1000Base-T (RJ-45 connector)   
• Graphics processor : ATI RADEON HD2600 series or higher

nVIDIA GeForce 8600 series or higher
nVIDIA Quadro FX550 series or higher

• Display card : 1920 x 1200 pixels or higher
• Web browser : Internet Explorer Ver.6.0 or higher

■Connecting the Camera to Your PC &P8 - P12

To set the network information below, see "Quick Reference".

1

2

3

Setting up the network information of 
the camera

Setting up the network information of 
the computer

Viewing live video from the camera
7
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Connections
8

This camera provides simultaneous delivery of video in the JPEG and H.264 formats and also 
bi-directional video between the camera and PC.

● Do not use the power supply of the camera.

● Do not supply power to the PoE hub or PoE power adapter until the camera installation 
is finished.

Connection when Using PoE (Power over Ethernet) Power Supply

SD OUT

HDMI

✱1
✱1

✱1 ✱1

A Connect the camera to the LAN through a switching hub using 
shielded LAN cables.

You may extend the transmission distance by using multiple switching hubs with PoE support.

For details on the extendable distance, please refer to the hub performance in the specifications, 
etc.

PC

HD Monitor

Monitor

Camera Control Unit

Switching hub
with PoE support

✱1: LAN cable: CAT5 or higher, straight type, Max. 100 m / 109 yds

PC

B Connect the camera to the LAN through a power adapter and a 
switching hub using shielded LAN cables.

Switching hub
Power adapter



Connections
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Connection when Not Using PoE (Power over Ethernet) Power Supply

✱1

✱1

✱1

Router or ADSL modem

PC

Switching hub

A Internet 
connection (&P10)

C LAN connection

B Direct connection

Power Supply
(AC24V/DC12V)

LAN cable 
(straight type)LAN cable 

(crossover type)

HD Monitor

Monitor

Camera Control Unit

LAN cable 
(straight type)

✱1: LAN cable: CAT5 or higher, straight type, 
100 m / 109 yds max.

HDMI

SD OUT
9
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About the “A Internet connection”
Port forwarding for the video port (HTTP/UDP) must be enabled on the broadband router.

For details on how to set port forwarding, please refer to your router's Instruction manual. 

b Port 1: JPEG/H.264 HTTP

b Port 2: H.264 UDP Unicast

To view H.264 video over the Internet, set port forwarding for UDP to enable communication 
using UDP protocol. However, it may not be possible depending on your network environment. 
Consult your network administrator.

MEMO:
If you install multiple cameras, for second and later cameras, specify different numbers for ports 1 and 2 
than those for the first camera via the network.
• Port 1: [NETWORK] → "PORT NUMBER"
• Port 2: [CODEC/STREAMING] → "UDP  (Unicast) PORT"

Router

To LAN port To WAN port

Port number (default): 80 (TCP)

IP address (default): 192.168.0.2

Port number (default): 80 (TCP)

• Set to same value as on LAN

Router

To LAN port To WAN port

Port number (default): 3939 (UDP)

IP address (default): 192.168.0.2

Port number (default): 3939 (UDP)

• Set to same value as on LAN
10



✱1 ALARM IN 1 ALARM
IN 2ALARM OUT

ZOOM
FOCUS

POWER

AC24V

GND DC
12VCOM

SD
OUT

EX-HDD
LAN

✱2

EX-HDD

(ZOOM)

(FOCUS)

(COM)
(IN2)

(COM)
(IN1)

(COM)
(AL OUT)

Connections

11

Do not connect the power cord until all other connections have been completed.

b ALARM IN 1 (“1” is selected)

b ALARM IN 2 (“2” is selected)

Alarm
input signal

Alarm
input signal

Alarm Signal Input

For switching between color and black/
white video modes using an external 
switch, the alarm input terminals can also 
be used.

If a lamp is connected to this cable, it will 
light up when an alarm signal is received 
or when the built-in motion sensor detects 
movement.

Alarm Signal Output

✱1 Thicker than 24 AWG, 600 m / 656 yds. max.

External hard disk

External 
peripheral device

BNC type

Connection for Zoom/Focus

HD Monitor

+6V/12V (FAR)

-6V/12V (NEAR)

+6V/12V (WIDE)

-6V/12V (TELE)

Camera Control Unit
(Options:VAC-70)
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POWER

DC
12V

✱2
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GND
~
~

–
+

GND
~
~

–
+

Shielded LAN cable
& “Connection when Using PoE (Power 

over Ethernet) Power Supply” (P8).
& “Connection when Not Using PoE 

(Power over Ethernet) Power Supply” 
(P9).

PC

Switching hub

PC

PC

✱2 Thicker than 18 AWG

AC 24V

DC 12V

(Non-PoE power supply)

Power Supply Connection

To prevent a fire hazard use any UL 
listed wire rated VW-1.

Monitor Connection

Using different cables from those 
specified here may attenuate the 
video and/or sync signals and 
interfere with correct transmission.

Check that +/- polarity is correct.

Thicker than RG-6U (5C-2V): 500 m / 547 yds. max.

LAN Connection
12
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Viewing Live Video

When the camera is turned on, live video is displayed on the monitor.

The following information also appears. The display position can be selected from 12 positions on the 
TV OUT SETTINGS screen via the network.

The zoom and focus of live video can be adjusted with the buttons under the side cover.

Network Camera      x1.0Network Camera      x1.0
E01             REC ALM1E01             REC ALM1
Network Camera      x1.0
E01             REC ALM1

Recording/downloading statusCamera title
• Set on NETWORK SETTING screen via 

the network.

Alarm status

Zoom magnification

✱ Insert at the end of this 
manual

Zoom and Focus

MENU SET

RESET

ZoomFocus

Auto-Focus (One-push)

Optical zoom: Up to 10x
Electronic zoom: Up to 160x
13
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Menu Screen List

The settings below can be configured on the menu of the camera unit.

• Configure other settings on the Web-version menu screen.

NETWORK SETNETWORK SET
SD/HDD SETSD/HDD SET
PASSWORDPASSWORD
FIRMWARE VERSIONFIRMWARE VERSION

   [MENU]_(MENU END)   [MENU]_(MENU END)

SETSET
SETSET
SETSET
SETSET

y
y
y
y

NETWORK SET
SD/HDD SET
PASSWORD
FIRMWARE VERSION

   [MENU]_(MENU END)

SET
SET
SET
SET

y
y
y
y

DHCP
IP ADDRESS
SUBNETMASK
GATEWAY
NETWORK SPEED
PORT
DEFAULT
   [MENU]_(MAIN MENU)

OFF
SET
SET
SET
NO LIMIT
00080
OFF

y
y
y

PASSWORD LOCK

PASSWORD CHANGE

   [MENU]_(MAIN MENU)

OFF

SET

y

y

       CAPACITY

SD     :   2GB
EX-HDD : 500GB

    FORMAT

   [MENU]_(MAIN MENU)

ON
OFF

NEW
FMT

SET y

FORMAT

    FIRMWARE VERSION
MAIN VER:
     0.00-00 (XXXXXX-XX)
SUB VER:
     0.00-00 (XXXXXX-XX)
MAC ADDRESS
     XX-XX-XX-XX-XX-XX
   [MENU]_(MAIN MENU)

MENU

Main Menu

Network Settings

Recording Media Settings

Password Settings

Firmware Version

Press the MENU button to return 
to the previous screen.
"(MENU END)" indicates "exit the 
menu screen".

&P15

&P16

&P17
14
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Setting up the network information of the camera

<Default Settings>
15

• DHCP : OFF
• IP Address : 192.168.0.2
• Subnet Mask : 255.255.255.0
• Gateway : 192.168.0.1

• Network Speed 
(bandwidth limitation) : NO LIMIT

• Port Number : 80

If you wish to use the default settings, the settings below are not necessary.

1 Select [NETWORK SET] with the jl 
buttons and press the SET button.

2 Select [DHCP] with the jl buttons and 
press the SET button.

•  appears next to the selection "OFF" 
indicating that you can change the 
setting.

Select "OFF" or "ON" with the jl 
buttons and press the SET button.
OFF: Manual setting (go to step 3)
ON: Automatic setting (go to step 5)

3 Select [IP ADDRESS] with the jl 
buttons and press the SET button.

Select the input position with the dc 
buttons, select a value with the jl 
buttons, and press the SET button.

4 Use the same procedure as in step 2 to 
set up [SUBNETMASK] and [GATEWAY].

5 Select [NETWORK SPEED] with the jl 
buttons and press the SET button.

•  appears next to the selection "NO 
LIMIT" indicating that you can change the 
setting.

Select the network speed (bandwidth 
limitation) with the jl buttons and 
press the SET button.
NO LIMIT, 128, 256, 512 (Kbps), 1, 2, 3, 4, 
5, 6 (Mbps)

6 Select [PORT] with the jl buttons and 
press the SET button.

Select the input position with the dc 
buttons, select a value with the jl 
buttons, and press the SET button.

7 Press the MENU button to exit the 
settings.

DHCP
IP ADDRESS
SUBNETMASK
GATEWAY
NETWORK SPEED
PORT
DEFAULT
   [MENU]_(MAIN MENU)

OFF
SET
SET
SET
NO LIMIT
00080
OFF

y
y
y

DHCP
IP ADDRESS
SUBNETMASK
GATEWAY

OFF
SET
SET
SET

y
y
y

      IP ADDRESS
IP ADDRESS
      192.168.000.002
      x

DHCP
IP ADDRESS
SUBNETMASK
GATEWAY
NETWORK SPEED
PORT
DEFAULT
   [MENU]_(MAIN MENU)

OFF
SET
SET
SET
NO LIMIT
00080
OFF

y
y
y

        PORT

PORT

   [MENU]_(NETWORK)

00080
x
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Formatting the Recording Media

An SD card or external hard disk can be installed on the camera to record live video.
16

Format the media before use.

● Installing an SD Card or External Hard Disk in the Camera
& Please refer to your media’s Instruction manual.

<Media recording area setting>
When the media is formatted on the camera menu screen, the size of the normal recording area and 
that of the alarm recording area are automatically allocated in the ratio "80 : 20".
If you wish to specify a different size ratio, format the media in [RECORD] → [SD MEMORY CARD/EX 
HDD SETTINGS] via the network.

1 Select [SD/HDD SET] on the main menu 
with the jl buttons and press the SET 
button.

A Media type
SD: SD card
EX-HDD: External hard disk

B Media size

C Format status
FMT : Formatted
NEW : New (unformatted) media, or 

media that needs formatting 
because files in it could not be 
read.

---- : Camera could not recognize the 
media

2 Select the media to format with the jl 
buttons and press the SET button.

•  appears next to the selection "OFF" 
indicating that initialization is possible.

3 Select "ON" with the jl buttons and 
press the SET button.

4 Select "FORMAT" with the jl buttons 
and press the SET button.

"CONTINUE?" appears. Select "YES" 
and press the SET button.
• Formatting begins.

       CAPACITY

SD     :   2GB
EX-HDD : 500GB

    FORMAT

   [MENU]_(MAIN MENU)

FORMAT

ON
OFF

NEW
FMT

SET y

A B C

SD     :   2GB OFFNEW

SD     :   2GB ONNEW

       CAPACITY

SD     :   2GB
EX-HDD : 500GB

    FORMAT

ON
OFF

NEW
FMT

SET y

FORMAT
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Setting a Password

A password can be set to restrict access to the camera menu screen.
■ Setting the Password
[PASSWORD LOCK]

1 Select [PASSWORD] in the main menu 
with the jl buttons and press the SET 
button.

2 Select [PASSWORD LOCK] with the jl 
buttons and press the SET button.

Move the input position with the dc 
buttons and select values with the jl 
buttons. When finished, press the SET 
button.
• If you set a password for the first time, 

enter "1234".

• If you enter a wrong password three 
consecutive times, you must repeat the 
procedure from the beginning.

3 When "OK" appears, press the MENU 
button.

• You return to the PASSWORD screen 
and [PASSWORD LOCK] now shows 
"ON".

■ Changing the Password
[PASSWORD CHANGE]

1 Select [PASSWORD] in the main menu 
with the jl buttons and press the SET 
button.

2 Select [PASSWORD CHANGE] with the 
jl buttons and press the SET button.

Enter the current password and press 
the SET button.

Enter a new password and press the 
SET button.

■ Releasing Password Lock
[PASSWORD LOCK]

Follow steps 1 to 3 of "Setting the Password".

• You return to the PASSWORD screen and 
[PASSWORD LOCK] now shows "OFF".

• If you enter a wrong password three 
consecutive times, you must repeat the 
procedure from the beginning.

PASSWORD LOCK

PASSWORD CHANGE

OFF

SET

y

y

      PASSWORD

        ****
        x

SET y

      PASSWORD

        1234
           x

SET y

PASSWORD LOCK

PASSWORD CHANGE

ON

SET

y

y

      PASSWORD

    NOW PASSWORD
        ****
        x

SET y

      PASSWORD

    NEW PASSWORD
        ****
        x

SET y

MEMO:
Change the password periodically to maintain security.
17
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Using the Supplied CD-ROM
■ Software
The supplied CD-ROM contains the application software shown below.
These applications can be installed to expand the scope of use of the data recorded through the 
camera.

● DLViewer_HDCDownloader
This is software for downloading and playing back video data (JPEG/H.264) recorded through the 
camera.
& Page 19 of this manual.

● VA-SW3050Lite
This is monitoring software for use with Sanyo’s cameras.
This software allows monitoring of live video from multiple cameras (up to 128 cameras).
& "VA-SW3050LITE" folder: Instruction Manual (PDF)

● H.264 Plug-in
This is software for playing back high-quality video.
This software is necessary for viewing H.264 live video on the screen via the network.

MEMO:
The separately available VA-SW3050 Server/Client can be purchased to record (JPEG) and play back 
live video on a PC.

■ Electronic manual
By using the electronic manual which is contained in the supplied CD-ROM, you can access 
extensive information from basic operation to advanced settings and functions, as well as 
troubleshooting.

● Requirements for viewing the electronic manual
Browser: Internet Explorer 6.0 or higher
• Make sure that JavaScript and Cookie are enabled.

1 Insert the CD-ROM into the CD drive of your computer and then double-click the “ ” 
icon.

2 Select the preferred language.

The electronic manual opens.

& You can also refer to “How to use this manual” to better understand the structure of the 
electronic manual and the description of individual screens.

● To open and view the instruction manual for the application software
You need Adobe Reader installed on your PC.
If it has not been installed on your PC, visit the Adobe website at http://www.adobe.com to download 
and install the free software program.
18
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Downloading and Playing back Recorded Video
- Using "DLViewer_HDCDownloader" Software -

This camera allows live video to be recorded.

The supplied software can be used to download live video recorded through the camera to your PC for 
playback.

■ HDC Downloader (Software for Downloading) &P20
Video data recorded on an SD card or hard disk can be downloaded to a PC.
• You can select JPEG or H.264.
• You can search for video data to be downloaded by date and time or by alarm event.
• You can connect media (an SD card or hard disk) to your computer to copy video data.

■ DLViewer (Software for Playback) &P21
This is used to play back downloaded video data.
• JPEG or H.264 can be played back.
• Images can be saved and printed.

"HDC Downloader" and "DLViewer" can be 
installed at the same time.

1 Insert the supplied CD-ROM into your 
PC’s CD-ROM drive.

2 Execute "Setup.exe" in 
"DLViewer_HDCDownloader" folder.

The installer will start. Follow the on-screen 
instructions to install the software.

Installation folder:

C:\Program Files\SANYO\HDC Utilites

When installation is finished, check the 
Internet options.

• Click [Tools] → [Internet Options] in 
Internet Explorer.

1 [Security] tab → [Custom level]

• Make sure that "Run ActiveX controls 
and plug-ins" is set to "Enable".

2 [Advanced] tab

• Make sure that [Security] → [Check for 
server certificate revocation] is 
unchecked.

If you attempt to play back H.264 video when 
the "H.264 Plug In" is not installed on your PC, a 
warning screen will appear.

Follow the on-screen instructions to install the 
plug-in.

Installing HDC Downloader and DLViewer "H.264 Plug In"
19
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HDC Downloader Operation Flow

2 Click "Copy from SD/HDD" and 
specify the drive and folder of the 
SD card or hard disk.

3 Select the type of image/video to be
downloaded (JPEG or H.264).

4 Click the  button.

The HDC Downloader screen appears.
1

A Download video data recorded on an 
SD card or external hard disk to your 
PC. &P22

B Connect the SD card or external hard 
disk to your PC and copy the required 
image/video data from it. &P26

2 Click "Download from Camera" and 
enter the network information.

3 Select the type of image/video to be 
downloaded (JPEG or H.264).

4 Select the search method.

• Password: download

5 Specify the folder that contains the data you want to download and the folder to 
which the data will be downloaded.

6 Click the  button.
20
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DLViewer Operation Flow

The DLViewer screen appears.1

2 Select the language.

3 Select the type of image/video to play back (JPEG or H.264) and 
specify the folder.

[Example]

Operation panel
&P27

Click
21
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A Download video data recorded on an SD card or external hard disk 
to your PC.

2 Select the display language.

3 Click the "Download from Camera" radio 
button.

4 Configure the network settings that are 
required for connection to the camera.

1IP address or URL

Enter the IP address (or URL) of the 
camera.

Default setting: 192.168.0.2

2Port

Enter the port number of the camera.

Default setting: 80

3SSL

If you wish to transmit image/video using 
SSL encryption, select this check box.

• The port number will change to "443".

4Proxy

If you will use a proxy server, select this 
checkbox and enter the server address (or 
URL) and port number.

5Password

Enter the password of the download user 
set in the camera.

• If you are entering the password for the 
first time, enter "download".

6Connection status display

The status of the connection with the 
camera is displayed.

5 Select the type of image/video to be 
downloaded (JPEG or H.264).

To download both JPEG and H.264, select 
both types.

6 Select the search method.

See the following for detailed explanations 
of the search methods.

• Time/Date Search:

Open the Time/Date Search screen.

& Carry out the procedure 
explained in "Download by Time/
Date". (P23)

• Alarm Search:

Open the Alarm Search screen.

& Carry out the procedure 
explained in "Download by Alarm 
Event✱1". (P23)

Downloading Recorded Video (HDC Downloader)

2
1

3

4
5

22
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■ Download by Time/Date

1 The start point [Top] and end point [End] 
are automatically displayed.

2 Set the [Start time] and [End time].

3 Click the [...] button and specify the 
folder in which the video data will be 
saved on your PC.

If you will play back the video data on a 
PC that does not have DLViewer 
installed, select the [with DLViewer] 
checkbox.

The DLViewer playback software will be 
copied to the destination folder together 
with the necessary files.

& Go to step 4. (&P24)

■ Download by Alarm Event✱1

The [Alarm list] does not contain any alarm 
when you switch to the [Alarm Search] screen.

1 Specify the date of the alarm event that 
you are searching for in [Date] and click 
[Search]. 

Alarm events will appear in the [Alarm list].

2 Click the alarm event that you wish to 
download in [Alarm list].

Multiple alarm events can be selected.

3 Click the [...] button and specify the 
folder in which the video data will be 
saved on your PC.

If you will play back the video data on a 
PC that does not have DLViewer 
installed, select the [with DLViewer] 
checkbox.

The DLViewer playback software will be 
copied to the destination folder together 
with the necessary files.

& Go to step 4. (&P24)

✱1 An alarm event is the data that was 
recorded when an alarm occurred.

2

1

3

4

 

1

2

3

4

23
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4 Click [Download].

The size of the download data is calculated 
and a confirmation dialog box appears.

5 Click [Yes].

Downloading starts.

When the download is finished, "Finished." 
appears.

The folder below is automatically created in 
the destination folder.

1Image format (JPEG/H264)

2Search method

• TD (Time/Date Search)
• AL (Alarm Search)

3Year-month-day (example: September 
22, 2008)

4Hour-minute (example: 10:30)

5File number

MEMO:

To cancel the download, click the [Cancel] 
button.
The download is cancelled; however, any 
data downloaded before the [Cancel] button 
is clicked is saved.

Click [Play].

"DLViewer" automatically starts and the 
video data is displayed.

MEMO:

Click [...] button and specify the folder that 
you wish to play back when you 
downloaded multiple video data.

& See "Playing back Downloaded 
Video Data (DLViewer)". (P27)

JPEG  AL  20080922  1030  001

1 2 3 4 5

(Explanation of the folder)

[Example]
24
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(Explanation of the alarm list)

ANo.:

Alarm number

BPre Alarm:

Start date and time of Pre Alarm recording.

CPost Alarm:

Start date and time of Post Alarm recording.

DDuration:

Approximate duration of recording (unit: 
minutes)

Maximum error: Approximately 2 minutes

ESize (KB):

Size of recorded data

FType:

Alarm type

• Alarm 1/2:

Data detected on alarm input terminal 1/2.

• Motion:

Data detected by the motion sensor.

• Network Failure:

Data recorded that was triggered by 
communication error.

• ALM1/2+M:

Data simultaneously detected by alarm 
input terminal 1/2 and the motion sensor.

• Rec button:

Data recorded with REC button.

GResult:

• Pass: Download succeeded

• Fail: Download failed

• No display: 

Download not yet executed

HPrevious/Next button:

Click this button to show the hidden alarms 
when the number of alarm events exceeds 
1000.

H

E FA B C D G
25
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B Connect the SD card or external hard disk to your PC and copy the 
required image/video data from it.

1 Select the display language.

2 Click the "Copy from SD/HDD" radio 
button.

3 Click the [...] button and specify the 
drive and folder of the SD card or hard 
disk.

4 Select the type of image/video to be 
downloaded (JPEG or H.264).

To download both JPEG and H.264, select 
both types.

5 Click [Time/Date Search].

[Alarm Search] cannot be used.

MEMO:
[Alarm Search] (specifying an image in the 
alarm list) cannot be used when copying 
image/video data from an SD card or hard 
disk.

& Carry out the procedure explained 
in "Download by Time/Date". (P23)

2
3

1

4

5

26
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■ Using the operation panel

1Slide bar

Slide the knob to move the playback point.

MEMO:

The date and time of the starting point and 
ending point of the file appear at the ends of the 
slide bar.

2Playback buttons

: Moves back by frames when the video is 
paused.

: Pauses playback and shows a still 
image.

: Moves forward by frames when the video 
is paused.

: Plays backward.

: Plays forward.

MEMO:

To zoom in or out at a point, move the mouse 
pointer to that point and rotate the mouse wheel. 
You will zoom in or out in five steps.

Note:

Moving back by frames and playing backward 
are not possible with H.264 video data.

3Speed bar (default setting: 3)

Slide the knob to change the playback speed.

• H.264: 5 steps
• JPEG: 10 steps

4Date and time display

Shows the date and time of the video data being 
played back.

The year/month/day format can be changed.

& See "Setting the Date Format". (P28)

5Time/Date Search

Specify the date and time of video data in the 
selected folder and click [GO].

The specified video data will be played back.

• If there is no video data with the specified 
date and time, the next video data will be 
played back.
If there is no next data, an error message will 
appear.

Playing back Downloaded Video Data (DLViewer)

1

2 3 4

5

27
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■ Saving and Printing Images

1 Click  on the toolbar.

2 Specify the folder, filename, and file 
type, and click [Save].

Image data is saved as a still image.

File type:

Bitmap or JPEG can be selected.

1 Click  on the toolbar.

2 Check the print conditions and click 
[OK].

b Displaying a title on the printed image

1Click [File] → [Title Input] on the menu bar.

• Up to 10 set titles are stored. Stored titles 
can be selected from the pull-down menu.

2Enter a title in the [Title Input] screen and 
click [OK].

■ Date and Time Display Settings

1 Select [View] → [Date Display Format] 
on the menu bar.

2 Select the display format and delimiter, 
and click [OK].

Select [View] → [Time Display Position] on 
the menu bar and click the desired display 
position.

Saving an Image

Printing an Image

Setting the Date Format

Setting the Time Display Position
28
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Main specifications
Appearance and specifications are subject to change without prior notice or obligations.

Television system VCC-HD4000P/VCC-HDN4000PC: PAL color standards
VCC-HD4000: NTSC color standards

Lens Image pickup device 1/2.5” CMOS sensor

Effective pixels 2,320 (H) × 1,728 (V), approx. 4.00 million pixels
Recording pixels 2,288 (H) × 1,712 (V), approx. 3.92 million pixels
Lens Focal length: f = 6.3 - 63.0 mm (Optical 10×)

F-number: F1.8 - 2.5
Electronic zoom: Max. ×16 (max. ×160 when combined with optical zoom)

Camera Video size (H.264) VCC-HD4000P/VCC-HDN4000PC:
(16:9) HD 1920×1080p, HD 1280×720p, 960×540p, 640×360p, 320×180p
(4:3) 1080×864p, 720×576p, 360×288p
VCC-HD4000:
(16:9) HD 1920×1080p, HD 1280×720p, 960×540p, 640×360p, 320×180p
(4:3) 1080×720p, 720×480p, 360×240p

Video size (JPEG) (16:9) HD 1920×1080, HD 1280×720, 1024×576, 640×360
(4:3) 4M 2288×1712, 4M 1600×1200, 1280×960, 1024×768, 800×600, 

640×480, 320×240
Synchronization method Internal synchronization

Lowest image illumination 2.0 lx (at F1.8, color, high gain, VGA)
0.1 lx (at F1.8, black-and-white, high gain, VGA)

Recording 
and 
playback

Picture quality BASIC, NORMAL, ENHANCED, FINE, SUPER FINE
Recording rate JPEG/H.264 selectable
Recording mode NORMAL/ALARM RECORDING: Timer recording

REC BUTTON RECORDING: Emergency recording
Backup recording in the event of a network recording failure: NORMAL (at 
failure detection), ALARM (timer recording)

I/O Video output HD output: HDMI connector
SD output: BNC connector
LAN: 10BASE-T/100BASE-TX/1000BASE-TX (RJ-45 connector)
USB port: External hard disk case (2.5" HDD) supported
SD card slot: 1 (SDHC, max. 32 GB)
Alarm input: Control terminal 1/2 (NO (Normally Open) or NC (Normally 
Closed)), also used for day/night switching input
Alarm output: Control terminal (NO/NC switching, 16V, 150mA, open 
collector)
External lens control: Zoom, Focus, Common (Voltage control: ±6 to ±12V)
Operation buttons: MENU, SET, RESET, cursor buttons (4)

Network Image/video compression H.264/JPEG
Picture quality BASIC, NORMAL, ENHANCED, FINE, SUPER FINE

Bandwidth NO LIMIT or selectable
Interface 10BASE-T/100BASE-TX/1000BASE-TX (PoE)
Protocol TCP/IP, UDP, HTTP, HTTPS, SMTP, NTP, DHCP, FTP, UPnP, DDNS

Simultaneous access 16
Security BASIC authentication (ID/password), SSL supported

Others Operating ambient 
temperature/humidity

–10 to +50°C, 90% RH or less (no condensation)

Power source DC12V-15V
AC24V ±10%, 50/60Hz

Power consumption 12.3 W

Weight 710 g
29
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b Service
The camera is a precision instrument. Handle it carefully and always follow the safety precautions. 
If the camera requires service, never try to repair it yourself or open the casing.
For servicing, maintenance, or repairs, consult your dealer or an Authorized Sanyo Service Center.

bNotes on data storage
• It is recommended that important data be copied to a separate medium.
• In the following situations, it is possible that recorded data may be lost (destroyed). Our company 

bears absolutely no responsibility for damages or profits loss due to the loss of data.
- The medium (SD card or external hard disk) is not used correctly.
- The medium is not installed on the device correctly.
- The medium is subjected to electrical or mechanical shock.
- The card is removed or the power is turned off while the card is being accessed.
- The medium has reached the end of its service life.

bOptions
• Recording/Playback Software: VA-SW3050 Server/Client
• Camera Control Unit: VAC-70
• SANYO-specified external hard disk case: VA-HDC4000

For more information on the recommended hard disks, check the SANYO website:
• SD card (2 GB to 32 GB)

For more information on recommended SD cards, check the SANYO website:

www.sanyosecurity.com/
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Recording times and target sizes
<CONTENTS>

b Recording time by resolution

1 Hard disk recording time .......................................P1

2 SD memory card recording time ...........................P3

1 Hard disk recording time .......................................P5

2 SD memory card recording time ...........................P7

b Target size by resolution.........................P9

VCC-HD4000P/VCC-HDN4000PC

VCC-HD4000
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1

■ Recording time by resolution ■ Durée d'enregistrement par résolution
■ Aufnahmezeit nach Auflösung ■ Tiempo de grabación por resolución
■ 根据分辨率设置的录像时间

1 Hard disk recording time 1 Durée d'enregistrement du disque dur
1 Festplatte Aufnahmezeit 1 Tiempo de grabación de disco duro
1 硬盘录像时间

• This table shows the total values for the normal area and the alarm area.

• Ce tableau indique les valeurs totales pour la zone normale et la zone d'alarme.

• In dieser Tabelle werden die Gesamtwerte des normalen Aufnahmebereichs und der Alarmaufnahmebereichs aufgeführt.

• Este cuadro muestra los valores totales para el área normal y el área de alarma.

• 本表显示正常区域和警报区域的总值。

80GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate 

(ips)

H.264
(16:9)

1920 × 1080p 25  14.4  16.5  19.2  23.0  28.8
12.5  15.9  18.4  21.9  27.1  38.3

1280 × 720p 25  17.4  20.6  25.0  31.9  45.9
12.5  19.5  23.0  28.1  35.9  52.2

960 × 540p 25  23.0  28.1  35.9  49.9  88.0
12.5  28.8  35.1  45.0  62.7  103.8

640 × 360p 25  63.7  77.4  97.7  132.4  205.5
12.5  71.6  86.0  108.7  145.8  225.6

320 × 180p 25  225.6  267.5  319.3  396.1  546.1
12.5  250.1  294.8  348.3  441.6  603.2

H.264
(4:3)

1080 × 864p 25  17.4  20.6  25.0  31.9  45.9
12.5  19.5  23.0  28.1  35.9  52.2

720 × 576p 25  32.9  40.0  51.2  71.6  116.4
12.5  35.9  43.8  56.0  78.4  129.4

360 × 288p 25  114.1  137.1  174.5  234.8  370.6
12.5  126.6  153.6  191.9  261.4  410.2

JPEG
(16:9)

1920 × 1080

5  14.0  16.1  19.3  24.0  32.0
2.5  27.9  32.3  38.6  48.1  64.1
1  69.8  80.7  96.5  120.1  160.2

0.5  139.5  161.4  193.1  240.3  320.3
0.2  348.8  403.5  482.7  600.7  800.8
0.1  697.6  806.9  965.4  1201.4  1601.7

1280 × 720

8  18.0  20.2  23.1  30.0  45.0
5  28.8  32.3  37.0  48.0  72.0

2.5  57.7  64.5  73.9  96.1  144.1
1  144.2  161.4  184.8  240.2  360.2

0.5  288.3  322.7  369.6  480.4  720.4
0.2  720.8  806.8  924.0  1201.0  1801.1
0.1  1441.5  1613.6  1848.0  2402.1  3602.2

1024 × 576

12.5  19.7  22.2  28.3  36.8  55.7
8  30.7  34.6  44.3  57.5  87.1
5  49.1  55.4  70.9  92.0  139.3

2.5  98.3  110.9  141.7  183.9  278.7
1  245.7  277.1  354.3  459.8  696.7

0.5  491.3  554.3  708.6  919.5  1393.4
0.2  1228.3  1385.7  1771.6  2298.8  3483.4
0.1  2456.6  2771.4  3543.2  4597.5  6966.9

640 × 360

25  15.4  17.3  22.2  28.8  43.2
12.5  30.9  34.6  44.3  57.6  86.3

8  48.2  54.0  69.2  90.0  134.9
5  77.2  86.4  110.8  144.0  215.8

2.5  154.4  172.9  221.6  287.9  431.6
1  385.9  432.2  553.9  719.9  1079.0

0.5  771.9  864.4  1107.9  1439.7  2157.9
0.2  1929.6  2161.0  2769.7  3599.4  5394.9
0.1  3859.3  4321.9  5539.5  7198.7  10789.7

VCC-HD4000P/VCC-HDN4000PC



L5CL2_XE_US(INSTRUCTION).book  2 ページ  ２００８年８月２５日　月曜日　午後３時４３分
• Recording time varies depending on the recording rate and recording image quality. The recording times indicated in the 
table are reference values when an external hard disk is installed on this camera that may vary depending on the video 
image quality and other conditions.

• La durée d'enregistrement varie en fonction du taux d'enregistrement et de la qualité de l'image enregistrée. Les durées 
d'enregistrement indiquées dans le tableau sont des valeurs de référence quand un disque dur externe est installé sur cette 
caméra ; elles peuvent varier en fonction de la qualité de l'image vidéo et d'autres conditions.

• Die Aufnahmezeit variiert je nach Aufnahmegeschwindigkeit und Qualität des aufgenommenen Bildes. Die in der Tabelle 
angeführten Aufnahmezeiten dienen als Referenzwerte, wenn für diese Kamera eine externe Festplatte installiert wurde, und 
können je nach Videobildqualität und anderen Bedingungen variieren.

• El tiempo de grabación varía en función de la tasa de grabación y de la calidad de las imágenes de grabación. Los tiempos 
de grabación que se indican en la anterior son valores de referencia cuando un disco duro externo está instalado en esta 
cámara los mismos que podrían variar en función de la calidad de imágenes y otras condiciones.

• 录像时间会根据录像速率和录像图像质量而变化。表中表示的录像时间为该摄像头安装外置硬盘之后的参考值，它
们可能会根据视频图像质量及其它条件而变化。

80GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate

(ips)

JPEG
(4:3)

2288 × 1712

2.5  16.0  19.0  23.4  30.4  43.2
1  40.1  47.5  58.5  75.9  108.1

0.5  80.1  95.1  116.9  151.8  216.2
0.2  200.3  237.7  292.3  379.4  540.6
0.1  400.5  475.3  584.5  758.8  1081.2

1600 × 1200

5  16.0  18.8  22.8  28.8  39.3
2.5  32.0  37.6  45.5  57.7  78.6
1  80.1  94.0  113.8  144.2  196.6

0.5  160.2  188.0  227.6  288.3  393.1
0.2  400.5  470.1  569.1  720.8  982.8
0.1  801.0  940.2  1138.1  1441.5  1965.5

1280 × 960

8  13.5  15.2  17.3  22.5  33.8
5  21.6  24.3  27.7  36.0  54.0

2.5  43.2  48.6  55.4  72.1  108.1
1  108.1  121.5  138.6  180.2  270.2

0.5  216.2  243.0  277.2  360.4  540.4
0.2  540.6  607.4  693.1  900.9  1351.1
0.1  1081.2  1214.8  1386.1  1801.8  2702.2

1024 × 768

12.5  12.1  13.5  17.3  22.5  33.9
8  18.9  21.1  27.0  35.1  53.0
5  30.2  33.8  43.2  56.1  84.7

2.5  60.5  67.6  86.5  112.3  169.5
1  151.2  168.9  216.2  280.7  423.7

0.5  302.4  337.8  432.4  561.5  847.5
0.2  756.0  844.6  1081.0  1403.7  2118.6
0.1  1512.1  1689.2  2162.0  2807.4  4237.3

800 × 600

12.5  19.7  22.2  28.3  36.8  55.7
8  30.7  34.6  44.3  57.5  87.1
5  49.1  55.4  70.9  92.0  139.3

2.5  98.3  110.9  141.7  183.9  278.7
1  245.7  277.1  354.3  459.8  696.7

0.5  491.3  554.3  708.6  919.5  1393.4
0.2  1228.3  1385.7  1771.6  2298.8  3483.4
0.1  2456.6  2771.4  3543.2  4597.5  6966.9

640 × 480

25  15.4  17.3  22.2  28.8  43.2
12.5  30.9  34.6  44.3  57.6  86.3

8  48.2  54.0  69.2  90.0  134.9
5  77.2  86.4  110.8  144.0  215.8

2.5  154.4  172.9  221.6  287.9  431.6
1  385.9  432.2  553.9  719.9  1079.0

0.5  771.9  864.4  1107.9  1439.7  2157.9
0.2  1929.6  2161.0  2769.7  3599.4  5394.9
0.1  3859.3  4321.9  5539.5  7198.7  10789.7

320 × 240

25  24.7  33.2  41.1  57.5  78.3
12.5  49.4  66.4  82.2  115.0  156.6

8  77.1  103.8  128.5  179.7  244.8
5  123.4  166.1  205.5  287.5  391.6

2.5  246.9  332.2  411.1  575.0  783.2
1  617.2  830.4  1027.7  1437.5  1958.0

0.5  1234.3  1660.9  2055.4  2875.0  3916.0
0.2  3085.9  4152.1  5138.5  7187.5  9790.1
0.1  6171.7  8304.3  10277.1  14375.1  19580.2
2
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2SD memory card recording time
2Durée d'enregistrement de la carte mémoire SD
2SD-Speicherkarte Aufnahmezeit
2Tiempo de grabación de la tarjeta de memoria SD
2SD 记忆卡录像时间

• This table shows the total values for the normal area and the alarm area.

• Ce tableau indique les valeurs totales pour la zone normale et la zone d'alarme.

• In dieser Tabelle werden die Gesamtwerte des normalen Aufnahmebereichs und der Alarmaufnahmebereichs aufgeführt.

• Este cuadro muestra los valores totales para el área normal y el área de alarma.

• 本表显示正常区域和警报区域的总值。

2GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate 

(ips)

H.264
(16:9)

1920 × 1080p 25  0.3  0.4  0.4  0.5  0.6
12.5  0.3  0.4  0.5  0.6  0.8

1280 × 720p 25  0.4  0.4  0.5  0.7  1.0
12.5  0.4  0.5  0.6  0.8  1.1

960 × 540p 25  0.5  0.6  0.8  1.1  1.9
12.5  0.6  0.8  1.0  1.4  2.3

640 × 360p 25  1.4  1.7  2.1  2.9  4.5
12.5  1.6  1.9  2.4  3.2  4.9

320 × 180p 25  4.9  5.8  7.0  8.6  11.9
12.5  5.4  6.4  7.6  9.6  13.1

H.264
(4:3)

1080 × 864p 25  0.4  0.4  0.5  0.7  1.0
12.5  0.4  0.5  0.6  0.8  1.1

720 × 576p 25  0.7  0.9  1.1  1.6  2.5
12.5  0.8  1.0  1.2  1.7  2.8

360 × 288p 25  2.5  3.0  3.8  5.1  8.1
12.5  2.8  3.3  4.2  5.7  8.9

JPEG
(16:9)

1920 × 1080

5  0.3  0.4  0.4  0.5  0.7
2.5  0.6  0.7  0.8  1.0  1.4
1  1.5  1.8  2.1  2.6  3.5

0.5  3.0  3.5  4.2  5.2  7.0
0.2  7.6  8.8  10.5  13.1  17.4
0.1  15.2  17.6  21.0  26.2  34.9

1280 × 720

8  0.4  0.4  0.5  0.7  1.0
5  0.6  0.7  0.8  1.0  1.6

2.5  1.3  1.4  1.6  2.1  3.1
1  3.1  3.5  4.0  5.2  7.8

0.5  6.3  7.0  8.1  10.5  15.7
0.2  15.7  17.6  20.1  26.2  39.2
0.1  31.4  35.1  40.3  52.3  78.5

1024 × 576

12.5  0.4  0.5  0.6  0.8  1.2
8  0.7  0.8  1.0  1.3  1.9
5  1.1  1.2  1.5  2.0  3.0

2.5  2.1  2.4  3.1  4.0  6.1
1  5.4  6.0  7.7  10.0  15.2

0.5  10.7  12.1  15.4  20.0  30.4
0.2  26.8  30.2  38.6  50.1  75.9
0.1  53.5  60.4  77.2  100.1  151.8

640 × 360

25  0.3  0.4  0.5  0.6  0.9
12.5  0.7  0.8  1.0  1.3  1.9

8  1.1  1.2  1.5  2.0  2.9
5  1.7  1.9  2.4  3.1  4.7

2.5  3.4  3.8  4.8  6.3  9.4
1  8.4  9.4  12.1  15.7  23.5

0.5  16.8  18.8  24.1  31.4  47.0
0.2  42.0  47.1  60.3  78.4  117.5
0.1  84.1  94.1  120.7  156.8  235.0

VCC-HD4000P
3
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• Recording time varies depending on the recording rate and recording image quality. The recording times indicated in the 
table are reference values when an SD memory card is installed in this camera that may vary depending on the video image 
quality and other conditions.

• La durée d'enregistrement varie en fonction du taux d'enregistrement et de la qualité de l'image enregistrée. Les durées 
d'enregistrement indiquées dans le tableau sont des valeurs de référence quand une carte mémoire SD est installée sur 
cette caméra ; elles peuvent varier en fonction de la qualité de l'image vidéo et d'autres conditions.

• Die Aufnahmezeit variiert je nach Aufnahmegeschwindigkeit und Qualität des aufgenommenen Bildes. Die in der Tabelle 
angeführten Aufnahmezeiten dienen als Referenzwerte, wenn für diese Kamera eine SD-Speicherkarte installiert wurde, und 
können je nach Videobildqualität und anderen Bedingungen variieren.

• El tiempo de grabación varía en función de la tasa de grabación y de la calidad de las imágenes de grabación. Los tiempos 
de grabación que se indican en la tabla son valores de referencia cuando una tarjeta de memoria SD está instalada en esta 
cámara los mismos que podrían variar en función de la calidad de imágenes y otras condiciones.

• 录像时间会根据录像速率和录像图像质量而变化。表中表示的录像时间为该摄像头安装 SD 记忆卡之后的参考值，它
们可能会根据视频图像质量及其它条件而变化。

2GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate 

(ips)

JPEG
(4:3)

2288 × 1712

2.5  0.3  0.4  0.5  0.7  0.9
1  0.9  1.0  1.3  1.7  2.4

0.5  1.7  2.1  2.5  3.3  4.7
0.2  4.4  5.2  6.4  8.3  11.8
0.1  8.7  10.4  12.7  16.5  23.6

1600 × 1200

5  0.3  0.4  0.5  0.6  0.9
2.5  0.7  0.8  1.0  1.3  1.7
1  1.7  2.0  2.5  3.1  4.3

0.5  3.5  4.1  5.0  6.3  8.6
0.2  8.7  10.2  12.4  15.7  21.4
0.1  17.4  20.5  24.8  31.4  42.8

1280 × 960

8  0.3  0.3  0.4  0.5  0.7
5  0.5  0.5  0.6  0.8  1.2

2.5  0.9  1.1  1.2  1.6  2.4
1  2.4  2.6  3.0  3.9  5.9

0.5  4.7  5.3  6.0  7.8  11.8
0.2  11.8  13.2  15.1  19.6  29.4
0.1  23.6  26.5  30.2  39.2  58.9

1024 × 768

12.5  0.3  0.3  0.4  0.5  0.7
8  0.4  0.5  0.6  0.8  1.2
5  0.7  0.7  0.9  1.2  1.8

2.5  1.3  1.5  1.9  2.4  3.7
1  3.3  3.7  4.7  6.1  9.2

0.5  6.6  7.4  9.4  12.2  18.5
0.2  16.5  18.4  23.5  30.6  46.1
0.1  32.9  36.8  47.1  61.1  92.3

800 × 600

12.5  0.4  0.5  0.6  0.8  1.2
8  0.7  0.8  1.0  1.3  1.9
5  1.1  1.2  1.5  2.0  3.0

2.5  2.1  2.4  3.1  4.0  6.1
1  5.4  6.0  7.7  10.0  15.2

0.5  10.7  12.1  15.4  20.0  30.4
0.2  26.8  30.2  38.6  50.1  75.9
0.1  53.5  60.4  77.2  100.1  151.8

640 × 480

25  0.3  0.4  0.5  0.6  0.9
12.5  0.7  0.8  1.0  1.3  1.9

8  1.1  1.2  1.5  2.0  2.9
5  1.7  1.9  2.4  3.1  4.7

2.5  3.4  3.8  4.8  6.3  9.4
1  8.4  9.4  12.1  15.7  23.5

0.5  16.8  18.8  24.1  31.4  47.0
0.2  42.0  47.1  60.3  78.4  117.5
0.1  84.1  94.1  120.7  156.8  235.0

320 × 240

25  0.5  0.7  0.9  1.3  1.7
12.5  1.1  1.4  1.8  2.5  3.4

8  1.7  2.3  2.8  3.9  5.3
5  2.7  3.6  4.5  6.3  8.5

2.5  5.4  7.2  9.0  12.5  17.1
1  13.4  18.1  22.4  31.3  42.6

0.5  26.9  36.2  44.8  62.6  85.3
0.2  67.2  90.4  111.9  156.6  213.2
0.1  134.4  180.9  223.9  313.1  426.5
4
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1 Hard disk recording time 1 Durée d'enregistrement du disque dur
1 Festplatte Aufnahmezeit 1 Tiempo de grabación de disco duro
1 硬盘录像时间

• This table shows the total values for the normal area and the alarm area.

• Ce tableau indique les valeurs totales pour la zone normale et la zone d'alarme.

• In dieser Tabelle werden die Gesamtwerte des normalen Aufnahmebereichs und der Alarmaufnahmebereichs aufgeführt.

• Este cuadro muestra los valores totales para el área normal y el área de alarma.

• 本表显示正常区域和警报区域的总值。

80GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate 

(ips)

H.264
(16:9)

1920 × 1080p 30  14.4  16.5  19.2  23.0  28.8
15  15.9  18.4  21.9  27.1  38.3

1280 × 720p 30  17.4  20.6  25.0  31.9  45.9
15  19.5  23.0  28.1  35.9  52.2

960 × 540p 30  23.0  28.1  35.9  49.9  88.0
15  28.8  35.1  45.0  62.7  103.8

640 × 360p 30  63.7  77.4  97.7  132.4  205.5
15  71.6  86.0  108.7  145.8  225.6

320 × 180p 30  225.6  267.5  319.3  396.1  546.1
15  250.1  294.8  348.3  441.6  603.2

H.264
(4:3)

1080 × 720p 30  17.4  20.6  25.0  31.9  45.9
15  19.5  23.0  28.1  35.9  52.2

720 × 480p 30  32.9  40.0  51.2  71.6  116.4
15  35.9  43.8  56.0  78.4  129.4

360 × 240p 30  114.1  137.1  174.5  234.8  370.6
15  126.6  153.6  191.9  261.4  410.2

JPEG
(16:9)

1920 × 1080

5  14.0  16.1  19.3  24.0  32.0
3  23.3  26.9  32.2  40.0  53.4
1  69.8  80.7  96.5  120.1  160.2

0.5  139.5  161.4  193.1  240.3  320.3
0.2  348.8  403.5  482.7  600.7  800.8
0.1  697.6  806.9  965.4  1201.4  1601.7

1280 × 720

10  14.4  16.1  18.5  24.0  36.0
5  28.8  32.3  37.0  48.0  72.0
3  48.1  53.8  61.6  80.1  120.1
1  144.2  161.4  184.8  240.2  360.2

0.5  288.3  322.7  369.6  480.4  720.4
0.2  720.8  806.8  924.0  1201.0  1801.1
0.1  1441.5  1613.6  1848.0  2402.1  3602.2

1024 × 576

15  16.4  18.5  23.6  30.7  46.4
10  24.6  27.7  35.4  46.0  69.7
5  49.1  55.4  70.9  92.0  139.3
3  81.9  92.4  118.1  153.3  232.2
1  245.7  277.1  354.3  459.8  696.7

0.5  491.3  554.3  708.6  919.5  1393.4
0.2  1228.3  1385.7  1771.6  2298.8  3483.4
0.1  2456.6  2771.4  3543.2  4597.5  6966.9

640 × 360

30  12.9  14.4  18.5  24.0  36.0
15  25.7  28.8  36.9  48.0  71.9
10  38.6  43.2  55.4  72.0  107.9
5  77.2  86.4  110.8  144.0  215.8
3  128.6  144.1  184.6  240.0  359.7
1  385.9  432.2  553.9  719.9  1079.0

0.5  771.9  864.4  1107.9  1439.7  2157.9
0.2  1929.6  2161.0  2769.7  3599.4  5394.9
0.1  3859.3  4321.9  5539.5  7198.7  10789.7

VCC-HD4000
5
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• Recording time varies depending on the recording rate and recording image quality. The recording times indicated in the 
table are reference values when an external hard disk is installed on this camera that may vary depending on the video 
image quality and other conditions.

• La durée d'enregistrement varie en fonction du taux d'enregistrement et de la qualité de l'image enregistrée. Les durées 
d'enregistrement indiquées dans le tableau sont des valeurs de référence quand un disque dur externe est installé sur cette 
caméra ; elles peuvent varier en fonction de la qualité de l'image vidéo et d'autres conditions.

• Die Aufnahmezeit variiert je nach Aufnahmegeschwindigkeit und Qualität des aufgenommenen Bildes. Die in der Tabelle 
angeführten Aufnahmezeiten dienen als Referenzwerte, wenn für diese Kamera eine externe Festplatte installiert wurde, und 
können je nach Videobildqualität und anderen Bedingungen variieren.

• El tiempo de grabación varía en función de la tasa de grabación y de la calidad de las imágenes de grabación. Los tiempos 
de grabación que se indican en la anterior son valores de referencia cuando un disco duro externo está instalado en esta 
cámara los mismos que podrían variar en función de la calidad de imágenes y otras condiciones.

• 录像时间会根据录像速率和录像图像质量而变化。表中表示的录像时间为该摄像头安装外置硬盘之后的参考值，它
们可能会根据视频图像质量及其它条件而变化。

80GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate 

(ips)

JPEG
(4:3)

2288 × 1712

3  13.4  15.8  19.5  25.3  36.0
1  40.1  47.5  58.5  75.9  108.1

0.5  80.1  95.1  116.9  151.8  216.2
0.2  200.3  237.7  292.3  379.4  540.6
0.1  400.5  475.3  584.5  758.8  1081.2

1600 × 1200

5  16.0  18.8  22.8  28.8  39.3
3  26.7  31.3  37.9  48.1  65.5
1  80.1  94.0  113.8  144.2  196.6

0.5  160.2  188.0  227.6  288.3  393.1
0.2  400.5  470.1  569.1  720.8  982.8
0.1  801.0  940.2  1138.1  1441.5  1965.5

1280 × 960

10  10.8  12.1  13.9  18.0  27.0
5  21.6  24.3  27.7  36.0  54.0
3  36.0  40.5  46.2  60.1  90.1
1  108.1  121.5  138.6  180.2  270.2

0.5  216.2  243.0  277.2  360.4  540.4
0.2  540.6  607.4  693.1  900.9  1351.1
0.1  1081.2  1214.8  1386.1  1801.8  2702.2

1024 × 768

15  10.1  11.3  14.4  18.7  28.2
10  15.1  16.9  21.6  28.1  42.4
5  30.2  33.8  43.2  56.1  84.7
3  50.4  56.3  72.1  93.6  141.2
1  151.2  168.9  216.2  280.7  423.7

0.5  302.4  337.8  432.4  561.5  847.5
0.2  756.0  844.6  1081.0  1403.7  2118.6
0.1  1512.1  1689.2  2162.0  2807.4  4237.3

800 × 600

15  16.4  18.5  23.6  30.7  46.4
10  24.6  27.7  35.4  46.0  69.7
5  49.1  55.4  70.9  92.0  139.3
3  81.9  92.4  118.1  153.3  232.2
1  245.7  277.1  354.3  459.8  696.7

0.5  491.3  554.3  708.6  919.5  1393.4
0.2  1228.3  1385.7  1771.6  2298.8  3483.4
0.1  2456.6  2771.4  3543.2  4597.5  6966.9

640 × 480

30  12.9  14.4  18.5  24.0  36.0
15  25.7  28.8  36.9  48.0  71.9
10  38.6  43.2  55.4  72.0  107.9
5  77.2  86.4  110.8  144.0  215.8
3  128.6  144.1  184.6  240.0  359.7
1  385.9  432.2  553.9  719.9  1079.0

0.5  771.9  864.4  1107.9  1439.7  2157.9
0.2  1929.6  2161.0  2769.7  3599.4  5394.9
0.1  3859.3  4321.9  5539.5  7198.7  10789.7

320 × 240

30  20.6  27.7  34.3  47.9  65.3
15  41.1  55.4  68.5  95.8  130.5
10  61.7  83.0  102.8  143.8  195.8
5  123.4  166.1  205.5  287.5  391.6
3  205.7  276.8  342.6  479.2  652.7
1  617.2  830.4  1027.7  1437.5  1958.0

0.5  1234.3  1660.9  2055.4  2875.0  3916.0
0.2  3085.9  4152.1  5138.5  7187.5  9790.1
0.1  6171.7  8304.3  10277.1  14375.1  19580.2
6
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2SD memory card recording time
2Durée d'enregistrement de la carte mémoire SD
2SD-Speicherkarte Aufnahmezeit
2Tiempo de grabación de la tarjeta de memoria SD
2SD 记忆卡录像时间

• This table shows the total values for the normal area and the alarm area.

• Ce tableau indique les valeurs totales pour la zone normale et la zone d'alarme.

• In dieser Tabelle werden die Gesamtwerte des normalen Aufnahmebereichs und der Alarmaufnahmebereichs aufgeführt.

• Este cuadro muestra los valores totales para el área normal y el área de alarma.

• 本表显示正常区域和警报区域的总值。

2GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate 

(ips)

H.264
(16:9)

1920 × 1080p 30  0.3  0.4  0.4  0.5  0.6
15  0.3  0.4  0.5  0.6  0.8

1280 × 720p 25  0.4  0.4  0.5  0.7  1.0
12.5  0.4  0.5  0.6  0.8  1.1

960 × 540p 25  0.5  0.6  0.8  1.1  1.9
12.5  0.6  0.8  1.0  1.4  2.3

640 × 360p 25  1.4  1.7  2.1  2.9  4.5
12.5  1.6  1.9  2.4  3.2  4.9

320 × 180p 25  4.9  5.8  7.0  8.6  11.9
12.5  5.4  6.4  7.6  9.6  13.1

H.264
(4:3)

1080 × 720p 25  0.4  0.4  0.5  0.7  1.0
12.5  0.4  0.5  0.6  0.8  1.1

720 × 480p 25  0.7  0.9  1.1  1.6  2.5
12.5  0.8  1.0  1.2  1.7  2.8

360 × 240p 25  2.5  3.0  3.8  5.1  8.1
12.5  2.8  3.3  4.2  5.7  8.9

JPEG
(16:9)

1920 × 1080

5  0.3  0.4  0.4  0.5  0.7
2.5  0.5  0.6  0.7  0.9  1.2
1  1.5  1.8  2.1  2.6  3.5

0.5  3.0  3.5  4.2  5.2  7.0
0.2  7.6  8.8  10.5  13.1  17.4
0.1  15.2  17.6  21.0  26.2  34.9

1280 × 720

8  0.3  0.4  0.4  0.5  0.8
5  0.6  0.7  0.8  1.0  1.6

2.5  1.0  1.2  1.3  1.7  2.6
1  3.1  3.5  4.0  5.2  7.8

0.5  6.3  7.0  8.1  10.5  15.7
0.2  15.7  17.6  20.1  26.2  39.2
0.1  31.4  35.1  40.3  52.3  78.5

1024 × 576

12.5  0.4  0.4  0.5  0.7  1.0
8  0.5  0.6  0.8  1.0  1.5
5  1.1  1.2  1.5  2.0  3.0

2.5  1.8  2.0  2.6  3.3  5.1
1  5.4  6.0  7.7  10.0  15.2

0.5  10.7  12.1  15.4  20.0  30.4
0.2  26.8  30.2  38.6  50.1  75.9
0.1  53.5  60.4  77.2  100.1  151.8

640 × 360

25  0.3  0.3  0.4  0.5  0.8
12.5  0.6  0.6  0.8  1.0  1.6

8  0.8  0.9  1.2  1.6  2.4
5  1.7  1.9  2.4  3.1  4.7

2.5  2.8  3.1  4.0  5.2  7.8
1  8.4  9.4  12.1  15.7  23.5

0.5  16.8  18.8  24.1  31.4  47.0
0.2  42.0  47.1  60.3  78.4  117.5
0.1  84.1  94.1  120.7  156.8  235.0

VCC-HD4000
7
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• Recording time varies depending on the recording rate and recording image quality. The recording times indicated in the 
table are reference values when an SD memory card is installed in this camera that may vary depending on the video image 
quality and other conditions.

• La durée d'enregistrement varie en fonction du taux d'enregistrement et de la qualité de l'image enregistrée. Les durées 
d'enregistrement indiquées dans le tableau sont des valeurs de référence quand une carte mémoire SD est installée sur 
cette caméra ; elles peuvent varier en fonction de la qualité de l'image vidéo et d'autres conditions.

• Die Aufnahmezeit variiert je nach Aufnahmegeschwindigkeit und Qualität des aufgenommenen Bildes. Die in der Tabelle 
angeführten Aufnahmezeiten dienen als Referenzwerte, wenn für diese Kamera eine SD-Speicherkarte installiert wurde, und 
können je nach Videobildqualität und anderen Bedingungen variieren.

• El tiempo de grabación varía en función de la tasa de grabación y de la calidad de las imágenes de grabación. Los tiempos 
de grabación que se indican en la tabla son valores de referencia cuando una tarjeta de memoria SD está instalada en esta 
cámara los mismos que podrían variar en función de la calidad de imágenes y otras condiciones.

• 录像时间会根据录像速率和录像图像质量而变化。表中表示的录像时间为该摄像头安装 SD 记忆卡之后的参考值，它
们可能会根据视频图像质量及其它条件而变化。

2GB
Picture quality

SUPER FINE FINE ENHANCED NORMAL BASIC
Resolution Recording rate 

(ips)

JPEG
(4:3)

2288 × 1712

3  0.3  0.3  0.4  0.6  0.8
1  0.9  1.0  1.3  1.7  2.4

0.5  1.7  2.1  2.5  3.3  4.7
0.2  4.4  5.2  6.4  8.3  11.8
0.1  8.7  10.4  12.7  16.5  23.6

1600 × 1200

5  0.3  0.4  0.5  0.6  0.9
3  0.6  0.7  0.8  1.0  1.4
1  1.7  2.0  2.5  3.1  4.3

0.5  3.5  4.1  5.0  6.3  8.6
0.2  8.7  10.2  12.4  15.7  21.4
0.1  17.4  20.5  24.8  31.4  42.8

1280 × 960

10  0.2  0.3  0.3  0.4  0.6
5  0.5  0.5  0.6  0.8  1.2
3  0.8  0.9  1.0  1.3  2.0
1  2.4  2.6  3.0  3.9  5.9

0.5  4.7  5.3  6.0  7.8  11.8
0.2  11.8  13.2  15.1  19.6  29.4
0.1  23.6  26.5  30.2  39.2  58.9

1024 × 768

15  0.2  0.2  0.3  0.4  0.6
10  0.3  0.4  0.5  0.6  0.9
5  0.7  0.7  0.9  1.2  1.8
3  1.1  1.2  1.6  2.0  3.1
1  3.3  3.7  4.7  6.1  9.2

0.5  6.6  7.4  9.4  12.2  18.5
0.2  16.5  18.4  23.5  30.6  46.1
0.1  32.9  36.8  47.1  61.1  92.3

800 × 600

15  0.4  0.4  0.5  0.7  1.0
10  0.5  0.6  0.8  1.0  1.5
5  1.1  1.2  1.5  2.0  3.0
3  1.8  2.0  2.6  3.3  5.1
1  5.4  6.0  7.7  10.0  15.2

0.5  10.7  12.1  15.4  20.0  30.4
0.2  26.8  30.2  38.6  50.1  75.9
0.1  53.5  60.4  77.2  100.1  151.8

640 × 480

30  0.3  0.3  0.4  0.5  0.8
15  0.6  0.6  0.8  1.0  1.6
10  0.8  0.9  1.2  1.6  2.4
5  1.7  1.9  2.4  3.1  4.7
3  2.8  3.1  4.0  5.2  7.8
1  8.4  9.4  12.1  15.7  23.5

0.5  16.8  18.8  24.1  31.4  47.0
0.2  42.0  47.1  60.3  78.4  117.5
0.1  84.1  94.1  120.7  156.8  235.0

320 × 240

30  0.4  0.6  0.7  1.0  1.4
15  0.9  1.2  1.5  2.1  2.8
10  1.3  1.8  2.2  3.1  4.3
5  2.7  3.6  4.5  6.3  8.5
3  4.5  6.0  7.5  10.4  14.2
1  13.4  18.1  22.4  31.3  42.6

0.5  26.9  36.2  44.8  62.6  85.3
0.2  67.2  90.4  111.9  156.6  213.2
0.1  134.4  180.9  223.9  313.1  426.5
8
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■ Target size by resolution ■ Taille cible par résolution
■ Zielgröße nach Auflösung ■ Tamaño del objetivo por resolución
■ 根据分辨率设置的目标物体大小

• The target sizes are reference values that may vary depending on the video image quality and other conditions.
• Values in parenthesis are for NTSC.

• Les tailles cibles sont des valeurs référencées qui peuvent varier en fonction de la qualité d'image et d'autres 
conditions.

• Les valeurs entre parenthèses sont pour NTSC.

• Bei den Zielgrößen handelt es sich um Referenzwerte, die je nach Videobildqualität und anderen Bedingungen 
variieren können.

• Die Werte in Klammern gelten für NTSC.

• Los tamaños del objetivo y valores de referencia podrían variar en función de la calidad de las imágenes y otras 
condiciones.

• Los valores entre paréntesis son para NTSC.

• 目标物体大小为参考值，它们可能会根据视频图像质量及其它条件而变化。

• 括号中的值适用于 NTSC。

Picture quality
SUPER FINE FINE ENHANCED NORMAL BASIC

Resolution Recording rate 
(ips)

H.264
(16:9)

1920 × 1080p
25 (30) 8000 7000 6000 5000 4000

12.5 (15) 7250 6250 5250 4250 3000

1280 × 720p
25 (30) 6600 5600 4600 3600 2500

12.5 (15) 5900 5000 4100 3200 2200

960 × 540p
25 (30) 5000 4100 3200 2300 1300

12.5 (15) 4000 3280 2550 1830 1100

640 × 360p
25 (30) 1800 1480 1170 860 550

12.5 (15) 1600 1330 1050 780 500

320 × 180p
25 (30) 500 420 350 280 200

12.5 (15) 450 380 320 250 180

H.264
(4:3)

1080 × 720p
(1080 × 864p)

25 (30) 6600 5600 4600 3600 2500
12.5 (15) 5900 5000 4100 3200 2200

720 × 480p
(720 × 576p)

25 (30) 3500 2870 2240 1600 980
12.5 (15) 3200 2620 2050 1460 880

360 × 240p
(360 × 288p)

25 (30) 1000 830 650 480 300
12.5 (15) 900 740 590 430 270

JPEG
(16:9)

1920 × 1080 – 310 268 224 180 135
1280 × 720 – 150 134 117 90 60
1024 × 576 – 88 78 61 47 31
640 × 360 – 56 50 39 30 20

JPEG
(4:3)

2288 × 1712 – 540 455 370 285 200
1600 × 1200 – 270 230 190 150 110
1280 × 960 – 200 178 156 120 80
1024 × 768 – 143 128 100 77 51
800 × 600 – 88 78 61 47 31
640 × 480 – 56 50 39 30 20
320 × 240 – 35 26 21 15 11

VCC-HD4000P/VCC-HD4000/VCC-HDN4000PC
9
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Display Information
● Error message
E01: HDD ERROR
E02: SD CARD ERROR
E03: TEMPERATURE ERROR

● Warning message
W01: FAN WARNING
W02: POWER RECOVER/POWER LOSS
W03: USB CURRENT WARNING
W04: NORMAL RECORDING AREA FULL
W05: ALARM RECORDING AREA FULL
W10: HDD TEMPERATURE
W11: NO MEDIA

● System information
S01: RESTORE FACTORY SETTINGS
S02: FIRMWARE UPDATE:MAIN
S03: FIRMWARE UPDATE:SUB
S04: HDD FORMAT
S05: SD CARD FORMAT
S06: RESTORE SETTINGS/COPY RECORDING AREA SETTINGS: ON
S07: RESTORE SETTINGS/COPY RECORDING AREA SETTINGS: OFF
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Dimensions
AC6P1P3313--
5CL2/XE, US, C (0808KP-HS)

Accessories

95 (3.7)159 (6.2)

161 (6.3)

67
 (

2.
6)

69
 (

2.
7)

Unit: mm (inch)

1 2

*1 VCC-HD4000P : English/Français/Deutsch/中文简体
VCC-HD4000 : English/Français/Español
VCC-HDN4000PC : 中文简体

(VCC-HD4000)
*1

SANYO Electric Co., Ltd.
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